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(Q-Nos. 1 to 50
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\ ~(A) 5 (B) WAl
(_-D bl |
‘Jﬂ'tC) et O) e
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A . L - ; -
?/ e brothex:_ of B, Cis the father of D, E is the mother of B, Aand D are .

@ bro@ers. What is the relation of C with E ?
8 | )
(A) \ Sister (B) Sister-in-law
\ @ 6
) e, TE(C) Niece (D)  Wife
D il

o Wﬁwﬁwwﬁaﬁmmﬁmlaoﬁmﬂﬂ#%m%mﬁwﬁm
a@aﬁ?40ﬁawngq:agmﬁm5@aﬁrsotﬂHW|magmw

¥ e W w & 2
(A) 50 HReR (B) 40 HIX
(C) 30HX (D) 20 WX

Ashok started to move in the direction of north. After moving 30m, he turned to

his left and moved 40 m. Again he turned to his left and moved 30m. Now how

far is he from the starting point ? w/
(A) 50m ® 40m O c
t~-{C]/ 30 m

...........................................................................................................................................
--------------------------
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3. [l Wi s g CHAIR Y 53260 mur EAR 1 729 fof@T1 9T, @ HEAR
= Y femar s 2

(A) 3792 (B) 3729
(C) 3972 (D) - 3929
AL M
If _?I;I:RCI!R is coded in a symbolic language as 53269 and EAR as 729, then how
will HEAR be coded ? -4 3712
(A) 3792 - By . 3729
(© 3972 D) 3929
o AR A ko e SR I+, A
S Y4 +6
5+4-18 + 3 :
¥ 4 < 18 + 3 %1 HF &M S e
- &
B 26 B) 14
©) -34 D) 6
Il '+ mcans ' x','— "' means '+ ' and ' x ' means ' + ', what will be the value of

o+4-18+37

(A) 26 (B) 14
(C) -34 DIE 6
5. fefefed v | o 95 $t 7 S ¢
49
? 1 64
25 -1
16 1 '4
‘9
(A) 35 (B) 41

(_er 36 D) 40
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Find the missing character in the following question :

49
? 1 64
25 1
16 l 4
e
A) 35 B) 41
<) . 96 (D) 40
5. v e T 9 e e ad g o 2
(A) 1947 (B) 1 9-48
(C) 1950 (D) 1951
In which year was the 'Planning Commission' set up in India ?
(A) 1947 i (B) 1948- )
(© 1950 D) 1951
P ﬁmiﬁmﬁﬁﬁﬂﬁiﬂaaqﬁﬁrmﬁawg% ?
(A) Ca(OC)cl (B) Na(OC)Cl
(C) CacCO, D) KMnO,
Which of the following is chemical formula of Bleaching Powder ?
(A) | Ca (OC}) Cl (B) Na(OCl)Cl
(C) CaCOjg ' (D) KMnO, Y
[74263]&;1;-3 ............ RE.ST_503 4/41[
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Fresfiae 3 s 1 s 9% e foy e 5 A s o & 2
(A)  To dlo Sto Ieger wem (B) TWHo 'mnqmq
(C) % W (D) HEHI SGH FAM AT

National Education Day is celebrated on the birthday of

(A)  A.P.J. Abdul Kalam (B)  S. Radhakrishnan
S
(C)  Rajendra Prasad (D)  Maulana Abul Kalam Azad

FE Y TN Tl Rt el w T g & 2
(A) 2 ' B) 8

(©) 10 D) 16
The binary system of computer uses powers of

(A) 2 (B) 8

-

(C) 10 (D) 16

frfefaa & | fhas sl famam A fvera &1 o1 o % 2m 2
(A) IR HFALS (B) A TS

(C)  HIIYTEH TIES (D) TTHT SRS
Which of the following aqueus solutions will turn blue litmus to red ?
(A)  Copper oxide (B) Iron oxide

(C) Magnesium oxide (D)  Sulphur dioxide
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12.

13.

Frafefan & 4 @Rt gt wghe w9 @ eiR s Al
URVITFERY 1 @ I 7@l el § 2

GRS | (B) R s
(C) A TRsEERE (D)  FARGRIEET

Which of the following pollutant gases is not produced both naturally and as ¢

~ result of industrial activity ?

(A) Mcthane - (B)  Nitrous oxide s

(C) -+ Carbon dioxide (D)  Chlorofluorocarbon

‘TrAfeT’ e @1 & g4l & yey & v swam @ 9 et By g 2

(A) v el B fea=

© w<gs T (O)  gerRie a=

‘Synetics' is the methed used for catering to which category of children ?

(A) Gifted children (B) Backward children 7
J/Q/ Rctardcd children ' (D) Creative children 7

iR 39 F T F E 2

w) TH B) I

© e (D) =
‘Where is situated the capital of Myanmar ?

(A) Rangoon Vd | (B) Y_an goon
(C)  Naypyitaw (D) Burma

R T T T T T L TR LI L L] CELT LT TTE LTS ittt L T L L T T LT I L L L L L L L L L L L L L L LT LI TTTTTTLLTT LT LA
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A WA & WEet Re Te-Re 9

(A) - TS TR | () Hto IETIUEAERT

€ g=raw (D) e ¥Ro anﬂ:c'.av‘{

The first Indian Governor-General of independent India was

(A)  Rajendra Prasad i (B) C. Rajagopalachari #

(C)  Surinder Nath (D) B.R. Ambedkar

HETeH] 7T &1 IrReT S1dter fd feg gam ar 2

(A) WIS TR SR (B) et FEIGH W FREA FHMH

(C) B Y JRew &1 fuwR D) Teg Towt # wwan W@

Mahatma Gandhi's Champaran Movement was for which of the following ?

- (A) Civil disobedicnce movement

(B)  Solving the problems of indigo workers
(C) The security rights of Harijans

(D) Maintaining the unity of Hindu Society

N wang foeg dEell &1 ied TUH e % TH-fder ¥ 12 3uE §)

s o gad sifaw wen st
(A) 15 B) 17
(© 19 D) T q &L T L&\l
The average of 'threc consccutive odd numbers is 12 more than one third of the &
first of these numbers. What is the last of the three numbers ? & o i QEEL
: %5 " et
s R
(A) 15 ( 17 S 2,
9 & "‘(-____# - \.‘2'
cy 19 (D) none of these ,\/\5 ) /,;_5
“1 L e 7
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17.

18.

19.

[ 74268 ] Set-B

®. 7,500 Y A, g 3w ¢ & R frar s ¥ A A AR B W few s 2%
39 | | 3R B 3l ¢ w1 &8 7 : 13 % sqwid 0 &, @l B @I feha WIS gan 2
(A)  ¥. 1,400 (B) . 3,500
()  F. 2,600 ' (D) . 7,000

Rs. 7,500 is to be divided among A, B and C such that A's share to B's share is
_____—-"'
in the ratio 5 : 2 and B 's share to C's share is.in the ratio 7 : 13. How much

will B receive ?
}A] Rs. 1,400 _ (B) Rs. 3,500

(C]  Rs. 2,600 (D) Rs. 7,000

forlt =t T faeot 42 @0 &1 gWR i 1 Faeot @ g forgenr ewer, wum it
& SR HT S TATE 7

(A) 82 HHt (B) 16 Qe
© V32 @ | D) 8 &

The diagonal of a square is 442 em. The diagonal of another square whose area

is double that of the first square is

(A) 8Y2 cm . B)  16cm

) _Jfa2 cml (D) 8cm
tonﬁaﬁlﬁ#ﬁﬂﬁso%ﬁfﬁaﬁwﬁﬁﬁrﬁ%ﬁﬂamﬁm@éw
i ! UR B 1§ o wHg (Yawvg ) ¥

(A) 10 ' | (B) 11

€ 12 (D) 15

A train 100 m long is running at a speed of 30 km/hr. The time (in second) in

which it passes a man standing on the railway platform is
(A) 10 (B) 11

)/ 12 (D) 15

8/ 48
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22,

(A 19327 JfgfER (B) 1935 & Hfyias

---------------------------------------------------------------------
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AT 0 WA T HI0T ¥ 3R 3 (sec20 + tan20) = 5 ¥, A cos 20 1 T 4T @ ?

1 6 J3
L | B S
() % . D 1

If 0 is positive acute angle and 3 (sec2p + tan20) = 5, then the value -of cos 20 is

lAl--lz- (B) iz-?i

(©) 71_5 | - dD 1

Friciiaa o | frwenr i At foget & vides & w9 1 =@ fea e 2

() e e g ® '

(© @ e (D)  WRY =T

Which of the following is not used as a coolant in a nuclear reactor ? ‘
(A)  Liquid sodium metal (B)  Water

(C) Carbon dioxide gas ,LE- " Heavy water.

mewﬁﬁrﬂﬁiﬁﬁﬁ#ﬁmaﬁlﬁw%aﬁmwm?

(C) 1936 I Hfufam (D) 1947 1 sfm \

The Provincial Governments were constituted under the Act of

(A) 1932 (B) 1935

() 1936 | (D) 1947

|

-.“nu--:uuuououu-uuu.n----u.-u"n/ - u.ug-u;n;aé.. i /.l
Wah w0 I
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23.

24.

25

--------------

I’ 74268 ] Set-B ........................................ P 1 0 ! 48

faver 3 foeg & @ R 2w o 999, AU Higer e g1 & 2
@& W - B) T T I
) == B (D) 4

The highest coal-producing country in the world is in which of the following ?
(A)  India e (B) USA

(C)  China . (D) - Russia

aﬁﬂm@ﬁmﬁwwﬁmmﬁuﬁiwaﬁﬁmﬁﬁrﬂmm

HRT &
(A) Eﬁwﬁiﬁ k. (B) forgen o Shat
(€ e o wEE (o) 3 Fand A P

hY

Amritsar and Shimla are almost on the same latitude, but their climate

difference is due to

(A)  their distance fromsea ~ (B)  snowfall in Shimla
(C) pollution in Amritsar (]Z,)'L_,' the difference in their altitudes

T R G T B Qe 2

(A)  HEEHE j [B)_ - A

© I E Es (p) (e

Who is the constitutional head of the State Governments P
(A) .Chicf' Minister (B) Speaker

(C)  Judge of High Court (D)  Governor 2

RE-ST-608
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26. ﬁuﬂﬁ%wﬁaﬁmgﬂwmw%aﬁmﬁéwﬁwwwaﬂﬁ%l
I @ B dEm FA-E E ?
(A) 32 (B) 64

r . () 16 (D) 1024

The product of two positive integers is 2048 and'm;e of them is twice the other.
Then the smaller of the numbers is |
(A) 32 | | (B) 64
(C) 16 : - (D) 1024

, w5
27, A% J3=1.732 Rarme @ ztg FAAFE ?

(A) 11.732 - (B) 13.928
(C) 12.928 /LD} 13.925
N ﬁ is

= is given, then the value of
[l'ﬁ .1.732 is given, then %3

(N 11.732 (B) 13.928
C)  12.928 (D) 13925

0g. @ dEel i FEeH FAGEd 1820 T TERH WETEAE 26 &1 A T HEAT 130
¥, @ g} g ® -
Ay 70 (B) 1690
(C) 364 (D) 1264

The LCM of two numbers is 1820 énd their HCF is 26. If one number is 130,

then the other number is

(A 70 (B) 1690

(C) 364 (D) 1264

11/ 48
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29,

30.

31.

ferelY T & 2006, 120 @, A 3T FEAT FT 120% T BT 2

(A) 20 - | (B) 120

(C) 480 ' D) 720
If 120 is 20% ofl';l number, then 120% of that number will be -

c j _ 9.0 Lﬂ/\"ug’ ,E:;\U‘O
A 20 | ® 120 A o

(C) 480 /(pj/ 720

Iig AN B 20%, 10% 3R 5% Bl T Geh! Tehel GHeT T 41

(A)  31.6% (B) 31.5%

C) 31% _ (D) 314%

If the successive discounts are given as 20%, 10% and 5%, then the single
cquivalent discount is

A)  31.6% G B) 31.5%_

© 31% ' ‘D) 31.4%

oS 2019 # AT 4681 UL Hiew WAHS AR TREA Hi fastar e
g2 g

(A) g are . B)  Wfd Forehol

(C) g i o ' . (D) 'ﬁﬁﬁﬂﬁ%'—ﬁ"f

Who is the winner of 46th National] Women Chess Champioﬁship title, held or
July 2019 ? ' |
(A) Pratyusha Bodda ~A (B) Bhakti {ulkarni +«

(C) Surabhi Verma ' (D)  None of them

______
---------------------------------------

T L T TT TR AR RN LR R
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2. aHE H, R % IWTUA €

() Al T - ) m fagem
© e R AMg | i D) THEHE T
At present the Vice-President of India is g I _
(A)  Nitin Gadkari ! (8) Om Birla
© (C) M. Venkaiah Naidu _~ (D) None of them
33, ‘e (et wEt iR fet @ T e 3 U e foes sfeon s
(A) 2 3T, 2019 ® 20 T, 2018, :
© 2 313@'(', 2019 D) T ¥ HIS @

The National Initiative for School Heads' and Teachers' Holistic Advancement

(NISHTHA) teachcers' training programme was launched on

(A)  August 22, 2019 (B) August 22, 2018 -~
($)  October 2.20i9 (D) . None of these:
34, fovg &% ¥ SER o e T, 2018 § wER S s # AR S
(&) O (B) - WaE
(© S D) TEEIR

According to World Bank, -'which position is taken by India, among the largest

cconomy in the Global GDP Ranking, 2018 ?

A)  Fifth  (B) Seventh
©) Third (D) None of these | i
35. Ty frer <A, 2019 F wET F AE fFE 317, 2019 H W A 2
(&) AR HE | ®) W gEiEe i | i
(© o FEERH (D) T - - i

----------------------------------------------

[ 74268 | Set-B S | RE-ST-GOSI - 13/ 48
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36.

37.

Who has submitted the report for Draft of National Education Policy, 2019 -
May 31, 2019 ? '

(A)  Narendra Modi (B)  Ramesh Pokhriyal Nishank

(C) K. Kasturirangan (D)  None of them

‘ ﬁ%ﬁﬂﬁﬁ_mﬁﬁq—mﬁmwﬁﬁm%mwaﬂwy

BXF, DVI, FTL, HRO, ? '5?

(A) JoL | (B) KPM
(C) KPL (D) JPR
A

Which option will take place of (?) in the following letter pattern ?

BXF, DVI, FTL, HRO, ?
(A) JOL " (B) KPM
(€)  KPL ‘ (D) JPR

-ﬁmfaﬁaam-’j@mﬁmfﬂﬁ(p;%wmwaﬂm ?

% o Q b i

144, 100, 64, ?, 16, 4

(A, €38 (B) 25

(€) 36 (D) 63
-

Which number will take place of (?)in the following seﬁeé ?

144, 100, 64, ?, 16, 4

Ay 49
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ss. ok o e BT 2,0 g

(A 9 . B 12
© 15 - (D) 30 |

How many triangles are there in the following figure ?-

/T T\

A), - 9 | (B) 2

 © .18 - D) 30 g
0. o TERE W ER, X R TR O, T S H e, e w5
S ST ST A ST e o W w9 wd § uge ¥ fou R A o

w4t 7 |
W EmESES B W@
© N . O) =

If 'Rajd;)ot' is coded as'Car', 'Car’ as 'Aeroplane’, 'Aeroplane’ as "I_‘Efiin', 'Train' as

-

|
|

‘Bus’, then by which vehicle can you reach your destination in least time ?

(A)  Aeroplane T By - Trdin £
(C) Car _ (D) Bus -
" 40. e widfaw wmn o aft BLADE ®I SPTFA femar S, d 3§ ¥R W BALE 1
e 2 | | <1 PR
SN STPA . (B) TSAP
(Cy STAP (D) TSPA

Scanned with CamScanner
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41.

42,

43.

Il BLADE is coded in a symbolic language as SPTFA, then how will BALE b
coded ? : ;

(A)  STPA _ B) TSAP
(C)  SsTAP ., @IITSPﬁ

TR el et it ¥ 7o T sto S [T FT 74T & ?

A s wifae a9 B o fewRe =i

(C)  Fritewdet faaifid) it (D) g difae 9

What is the full form of USB as used in computer related activities ?

(A)  United Serial Bus (B)  Ultra Security Block
(C)  Universal Secﬁrity Block }D)’ Universal Serial Bus
- Fitar et g3t o 2

@A)  1930F o ® 1031F

(C) 19327H D) 1933%

Gandhi-Irwin Pact took place in

(A) 1930 “in e (B) 1931
© 1932 . g D) 1933
MR SR Tt & fomr i 9 »
(A) ST T foicren ey - A
(C) Tam HE< | D) TS W

-------------

.1 74268 ] Set-B

Who was the father of Indiap Renaissance ?
(A) Bal Gangadhar Tilak

(B) . Raja Rammohan Roy s |

(C) Swami Shraddhananda .

(D) | Dayanand Saraswati

----------------------------
............................................................................................................................

: 16 / 48
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45.

46.

o Sz e R e & e v & 2

207

(A)  1.551 fweeT | (B)  1.852 feeiHiet
(C) 2;012 %ﬁ'ﬂﬂa ' (D) 1.644 fFeidizy
One nautical mile is equal to

(A) ~ 1.551km | © (B)i. 1.852km ' *

(C)  2.012km ' (D) - 1.644km

qRE F A F TG TAvE & W B & 2

(o) FEEewm (B o =W

() o Teal (D) HRE &

Who was the Prime Minister of England at the time when India got

independence ?
(A) Winston Churchill (B) Tony Blair
(C) Clement Attlee ' (D) Margaret Thatcher

sty AR T S 1 S e % iR | weifde € 2

(A) 3BT 45 - (B) 3T 30 (1)

) ﬂﬂi@?zﬁn (D) DT 15 (1)

" Which article of the Constitution of India is related to the Right to Educaﬁon ?
(A)  Article 45 (B)  Article 30(1)
(C) Arliblc 21A . | (D) Ar_ticle 15(1)

[ 74268 | Set-B RE-ST-608 J 17 / 48
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26 WagH' § ang ¢ fird T P O € 2

47.
A TR | B) T
© e . o T
For which word, has the letter 'G’ been used in '2G spectrum’ ?
(A)  Government 5 (B) Gl;yba]
(C)  Generation , 1 (D) Google
48, ﬂw%aﬁﬁmm’fﬂ:{hm I & 2
(A) i S (B)  IifiTch S
© e s | ) T A
Mcndel's principle of inheritance is based on |
(A) - ~ sexual reproduction y (B)  asexual reproduction
(C) vcgetativle reproductjon : (D) all of these.
49. ﬁﬁwﬁ-mwwf@aﬁwaﬁwmm%? g
(A ST (B) o
© o (D) ¥mEr
- Which component of plants receivé§ stimulus for flowering ?
(A} Roots (B) Stems
(€) _Lcaves : (D)  Branches
50. ‘%ﬁmnﬁ'wmmmé% ?
(A SrEEEm ' B) fasmeer
© == o e
‘Do or Dic' is associated with the movement
(A) Non-cooperation . (B) Khilafat
AT vl
o T

.
...........................................................
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52.

53.

54.

[ 74268 | Set-B

--------
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T ri

COMPUTER SCIENCE
( Q-Nos. 51 to 150)

Frefat 3 @ e 1 TR T o § 2

(A)  Word Perfect (B) Easy Word

(C) MS Word ; (D) Eat kel Tl

Whiéh of the following is/ are word processing software ?

(A) Word Perfect _ (B) Easy Word

(& MS Word ' (D) Al of these

cpp H 1/0 HRIHA HA F T EH .o ¥et EEel T ST HE e
To perform I/O operations in CPP, we must USE .......coe. header file.

(A) <jostream.h> & j (B) <string.h>

(C) <math.h> (D)  <stdio.h>

“Ctrl + NFATE

(A) Save Document .(B) Open Document

(C)  Create New Document (.D] Close Document

Ctrl + N is used to

(A}  Save Document (B) Open Document

(C) Create New Document (D) C[oseDocument

. CPP PITE Bl coveveeirnes ﬁﬁTﬁTﬁT%1

CPP keywords are also called

(A) preprocessor (B) punctuation symbols

(D) reserve words

RE-ST-608

----------
----------------------------------------------------------------------------
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(A)

(C)

Placcholders (B)

Objects (D)

55. %% T Cross reference % ®9 3 741 ST Sl ¥ 2

Bookmarks

Word fields

What are inserted as cross-reference in Word ?

(A)

- (©)

56. frefcifad § @ ®19 we fawe faehed Tl € ?

(A)

(€) .

Placeholders (B)

Objccts (D)

Next Page (B)

Odd Page g (D)

Bookmarks

Word fields

Previous Page

Even Page

Which of the following is not the Section Break Option ?

(A)

(C)

Next Page ~ (B)

Odd Page | : (D).

57. DBMS & I 91 &

(A) Database Management System

(B) Databasel Master System |
(C) Databas:c. Management.étructure
(D) T 4§ i T

DBMS stands fm-'

(A) Databasc Management Systelm /
(B) Database Master System

(C) Databasc Management Structure
(D) Nonclof these

Previous Page

Even Page

Scanned with CamScanner
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59.

60.

61.

[ 74268 ] Set-B

‘What is a Firewall i

fgﬁﬁmﬁ,mwwﬁﬁﬁamma@qﬁﬂﬁWw%?

(B) On alternate page

D) i ¥ B w

(A) On first page

(c) Onecvery page

By dcfault, on which page the header or the footer is printed ?

(A)  On first page (B) On alternate Ipage

(C) Onevery page (D) None of these.

ﬁﬂﬁﬁ*/%aﬁﬁ?ﬂoperatorﬁmaﬁlﬁt@m% ? .

7\ B / |
| | p) @ ) g g

c %

Which opcratbr has highest pfcccdcnce in*/%7?

A (B) /
c) % = (D) All have same precedence
nCtrl + G Ll €

wctrl + G exccutes

(A) Open paragraph Dialog box activating Goto Tab

(B)y Open Page Setup. Dialog box actwatmg Goto Tab
alog box with actwatmg Goto Tab v

(C) Open Find and Replace Di

(D) Open Goto Dialog box
wga' Yzadh T T F z?
n Computer thwork ?

(A) The physical boundary of Network F
ter Network jﬂ

(B)  An opcrating system of Compu

ed to prevent unauthorized access S

(C) A system design
(D) Aweb browsing Software
21 / 48

Scanned with CamScanner

3@ Teachingninja.in



207.
62. IETF HHS! ¥ I Feeld €

The IETF standards of documents are called

'(A) RFC (B) RCF ol

€ IID - (D)  None of these
Serial Communication link T 321 Hufd F F fog fera 221 WUR 9gfq 5

IUANT BT & ?

(A)  Simplex

63.

(B)  Half-duplex
D) T

Which data communication method is used to transmit the data over a serial

(C) Full-duplex

communication link ?
(B) Half-duplex

(D) _ All of these ~

(A) Simplex
“(C) Full-duplex

64. 1P U I e 28T DR 1 ¢ 2

What is the minimum header size of an IP packet ?

(A) 16 bytes s (B) 10 bytes

(C) 20 bytes (D) 32 bytes

65. U T3 o1 U3 o6 AR &t &
Routing table of a router keeps track of
{A)  MAC Address Assignments
(B) /2885t Assignments to network devices
(C)  Distributed IP addresses to network devices 5
(D) ~ Routes to use for forwarding data to its destination

66, FrefeEd § ¥ B A1 AR qeen ww e g )

Which of the following is not External Security Threats ? \

(A)  Front-door Threats - (B)  Back-door Threats
(C)  Underground Threats . (D)  Denial of Service {DOS]/
[ 74268 ] Set-B RE-S;E‘:EB.E.. .‘.'““""."“"‘h“-..‘“"..-".““"“"“:"“"”"55“;{ 48
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67. APIPA I [P Ual YR T & ?

What is the IP Address range of APIpa -
(A)  169.254.0.1 to 169.254.0.254 .~
(B) 169.254.0.1 to 169.254.0.255
(C) 169.254.0.1 to 169.254.255 254
(D) = 169.254.0.1 to 169.254.255.255
68. f[rfcifad o @ = 221 fafma & dwafyg a0 =i & 2
| Which of the folléwing is: not the possible ways of data exchange ?
(A) Simplex (B) Multiplex
(C) Half-duplex (D)  Full-duplex ¥

69. meﬁ%aﬁamﬁmﬁm%aﬁa%ammwwm% |

The management of data flow bctween cornputers or demces or bctween nodes

in a network is called
(A)  Flow control ' () Data Control ./
(C) Data Managcﬁlcnt (D)  Flow Management
70. TCP &awH H, U o o e HAE 2
(A) It specifies the communication proces_é. oﬁ the two-end systems
(B) ' It specifies the quality of the data & coﬁnectjon
(C) It specifics the size of data
(D) T A
What does the port number in 2 TCP connection specify ?
(A) It specifies the communication process on the two-end systems
(B) It specifies the quality of the data & connection
(C) It specifies the size of data

(D) Allof these. -

-----------------------------------------------------------------------------------

RE-ST-608

amen
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(A)  Array k- (B)  Struct
(C)  Boolean g : (D) Int
........ s is a basic data lypcl.. '
() Array NS B) S@ct
(C)  Boolean 4 D) Int ./

73 Wum%ﬁmémwm%wm%mmﬁmww
fera < wepemr € 2
(A)  Slider Timing . ' | (B)  Slider Timer
(C)  Rehcarsal N Slide Show Setup
Whicﬁ option can be used to set custom timing for slides in a presentation ?
(A) Slider Timing . (B) Slider_'[‘imer
(C) Rchearsal . , (D) . Slide Show Setup .

73. diuserd {5 WM % T Module %_Wmﬂmwmt Iq FE AL

74,

Variables which can be accessed inside a module of the program is called

(A)  Global | ~ (B) Auto

(C) Static , - (D) Local J

msﬁ&aﬁ%iﬁqmﬁwwmvm% ?

Which key can be used to' view shde show ?

(A) FS

() ' F7 | ' (D) F8

X (B) F2 7

aar®
ane®
.......
...................................................... -
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LR Character 9T text dataﬁ@ﬁamﬁ%ﬁaﬂgﬁwﬁ?ﬁ%
To store character or text data we need
(A)  numeric variable - (B) string variable .
(C) logipal function (D) array
76. T UF TRE VM 1 H UF T €
[Tow can we stop a slide show ? |
(A) Press the right arrow o []'3] Press Ctrl+A
(C) Press Escape .- (D)  Press Ctrl+S |
77.  Power Point, MS-office & frafataa os-3 Aedax § | S W 82 Fﬁﬁﬂﬁ 28
T & ?
(A) Organization Chart (B) Photo Album
(C) Equation Editor D) '. E:Iﬁ q ot
Power Point can display data from which of the following add-in software of MS
office ?
(A)  Organization Chart )/ (B)  Photo Album
(C) Equation Editor }) All of these :
S i i f77 @ spelling FH spelling ST S ) i fo <1 T €

The spcfling dialog box can be involved by choosing spelling from ............

menu. .

(A) Tools (B) View

(C) File (D)  Insert
rafi Folt € 2

o 3 T aferE H H A TP

Which onc is a primary Key in a bank customer table ?
(B) Admission number

(A) UID number .
(D) PAN

Account number / ,
i e

----------------------

RE-ST-608

ooooo
----------------
-------------------------------------------------------
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80.

81.

. B,

83.

84.

[ 74268 ] Set-B

Power Point slide HEEDIE 3

PoWer Point slide can have |
(A) title, text, graphs (B) drawn objects, shapes

(C)  clipart, drawn art, visual & Qzﬂ any of these

w1 3 faelt <t ¢ e et A

Right clicking on something in wgrd

(A)  deletes the object : _ .

(E.:]I 'is nothing but the right mouse button is there for left handed people
(C) opens the short-cut list/

(D) inserts the picture

> = € Tsh
- (A) instance ' ' (B) design
(C) " data type: . . (D) operator

>=is a/an

(A) instance B) dgsign

(C) data type : | (D) operato::/

Autocorrect tool € :

The autocorrect tool - .

(A)  provides statistics about yoﬁr document

(B) displays words yﬂ;'ith the same or similér meaning

(C) © checks the grammar in the document "

(D) checks for misspelled words as you type and correct them as define /
Uch class H & | cncapsulated ﬁh‘m SIGIES 7

(A) Program & Process (B) Function and Data

(C)  File and Disk (D) Variable and Constant

o
........

'''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''

26 | 48
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85.

86.

87.

""""""""""

[ 74268 ) Set-B

" To cut or copy text you must

.......
.............
................................................

Which is cncapsulated in a class ?

(A)  Program & Proces : ' :
3 (B) Function and Data .~

(C) Filc and Disk i
; (D) Variable and Constant

Word J&IEST 1, Hyﬁcrlink Tive WeRg w3 & foT0 39 a1 ehdl €

(A) . Ctrl + Shift + FO key (B)  Shift + F9 key
(C)  Ctrl + Alt key D) T A

To display hyperlink field in a Word document, you can press the

(A) Ctrl + S_hift +FO key .., (B) - Shift + F9 key "~

(C)  Ctrl + Alt key | (D)  none of these

ﬁﬂﬁ‘{}lﬁqﬁz&bstract@am% ?

l[f\l class (B) double

(C) int (D)  string

Which is an Abstract data type ?

(A) class s | (B) double

(C) int (D)  string

%ﬁ;ﬁzﬁmaﬁraﬂ%%ﬁﬂﬁmﬁwm'mﬁq
e button E

(A)  Click the remove /duplicat
(B)  First highlight the text and clic

menu
(C) Click on File menu )
o) T B Bl

first

(A)  Click the remove /duplicate button

(B)  First highlight the text and click the

~ menu
(C) Click on File menu

(D)  None of these

--------------------------------------------------

[207

k the Copy or Cut command from edit

Copy or Cut command from edit
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88.

89.

90.

91,

...........................................................................................................

[ 74268 ] Set-B

SgeEe ¥ ferg v Wt § 7
(A) Animal to Cat
(C)  Lock to key

Which is correct for inheritance ?
(A) Animal to Cat
(C) I:O(;k to key

%HIS Cross reference EW %

(A) View menu

(C) Insert menu

The command Cross reference is available in

(B)

(D)

(B)

(D)

(B)

(D)

(A)  View menu / (B)
(C) In-sert mcnu (D)
fordl} arfetent 1 TP 91 Bies Sel 7Tl ¢
| (A) Data type . (B)
(C) Attribute . (D)
Column or Field of a table is called
(A) Data type (B)
(C\WVALdEERe (D)
TCP/IP & T&h
(A) Network Hardware (B)
(C)  Protocol (D)
TCP/IP is a
(A) Network Hardware (B)
(C)  Protocol o (D)

Variable to constant

Data to Program

Variable to constant

' Program
Data toFrogram

Format menu

Tools menu

Format menu

Tools menu

Row name

Entity name

Row name

Entity name"

“Network Software

@

Network Software

None of these

"
an
|||||
------------------------------------------------------------------

Scanned with CamScanner

3@ Teachingninja.in



ﬁ-'-F g —— — .
207
g2. OSI®I QAN g
OSI stands for
(A) Open Soft ID &
(B) Open System ID ~
[C} Open System Intcrconnéctjgn ,
(D) Open Source [nformaﬁon
03. e UE Y W T i 1 e a1 2
(A) ARPA (B) NSF |
(C) NSA (D) gafr A FIE T2
The. Internet was originally a project of which agency ?
(A) ARPA T (B)  NSF
(C) NSA (D)  None of these
94i" ETMIL; ssivenees it R % ferg ST fRE S
HTML is used to create . '
(A) machine language program
(B) high level program
(C) webpage
(D) web server _
05, 'WWWW'@'W%
i . stands for _
'(I:;c co:::::::cgi:;m‘:?ﬂn 5 (B) World Wide Wildlife'ch k
(C) World Wi;ic Womcn's.Web | (D) World Wilde Women's Wee
%. wm%mﬁam@ﬁﬂﬁﬁz?%
. : &
A wc_baitc‘s front page/main page 1 el (1'3} Sem,ch oy
(A)  Browser Page bl
O HomePaEe s oo

RE-ST-

......
----------
.........
-------------------------------------------
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97.  HTML & @1 &Y &

Full form of HTML is
(A) Hyper Text Markup Language el
{.B) Hyper Text Manipulation Language
‘C) Hyper Text Managing Links
(D.) Hyper Text Manipulaﬁﬂg Links
98. Cmﬁputer Network %
(A)  Collection of hardware componenfs and computers
(B) Intcrcomiected by communication channels
(C) Sharing ;:)f resources and infofmatioﬁ
D) ¥ & g
Computer Network is
(A) Collection of hardware components and computers
(B) | Inte‘rconnected by communication channels

(C)  Sharing of resources and information

(D)  All of these

99,  Wiel®id &

/

(A) Agreements on how communication” components and DTEs are (¢

communicate

(B)  Logical communication channels for transferring data

(C)  Physical communication channels used for transferring data
(D) T | &I T&l

ol

---------------------------------------------------------------------------------------------
---------

[ 74268 | Set-B

-
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Protocols are

to
(A) Agreements on how communication components and DTEs. are

communicate- /

(B) Logical communication channels for transferring data
(C) Physical communication channels used for transferring data

(D)  None of these

100. 3 feamsw Jeu® A €, 31111

1 ice i i i ' ocess in
(A) a process in one device is able to exchange information with a pr

another device
(B) a process is running on both devices
(Ci PIDs of the processes running of different devices are game
o e @
Two devices are in network if

(A}  a process in one device is able to exchange information with a process in

another device
(B) a process is running on both devices

(C)  PIDs of the processes runnilng of different det_riccs are same

(D)  none of these

im.-mqvmmawcmfawfﬂmwﬁmﬁmﬁm%@ﬁﬁﬁmﬁ

IYGHT HIAT § 7

(A} Dot matrix printer | (B)  Digital plotter

(C) Linec printer | D) T E g
[7426313et ............. RESTsog ................................................................ 31,43
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102.

.103.

104.

..............

A high quality CAD system uses which of the following for printing, drawing anq
graphs ? | |

(A) | Dot matrix printer . | ' tB] Digital plotter
(C)  Linc printer ' (D) All of these
Frefeiaer o & 9 gz fearew 61 & 2

Which of the following _is not an input device ?

(A)  OCR |

(B) Opiical‘scanners'

(€)  Voice recognition device

(D) COM (Computer Output to Microfilm) / ;

HE & q 16ﬁ2ﬂaﬁﬂwﬁﬁnmmﬁaﬁﬂaﬁmmnﬁlﬁﬁam
%me'r

(A) 16 digits | (B) 6 digits
(C) 9 digits (D) ?ﬁﬁﬁuﬁr

The accuracy of the floating-point numbers rcpresentable In two 16-bit words of

a computcr is approximately

(A) 16 digits  (B) 6 digits
(C) 9 digits (D)  all of these
T CPU T&dT &

(A)  acard reader and a printing device
(B) an analytical engine and a contro] unit
(C) a qontrol unit and an arithmetic logic unit

(D) an arithmetic logic unit and a card reader

......................................................
....................
-----------
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A CPU contains
(A)  acard rcader and a printing device
'(B)  an analytical engine and a contro] unit
(C)  a control unit and on aﬁmoleﬁc logic unit ¢/

(D) an arithmetic logic unit and a card reader

l05. Tusier 1IBM ORlt F, cpu, fearw grew, S frwR i st afwa gewi
UF & S W oIl ST €1 3H S AN w1 ?

(A)  Motherboard _ (B) Breadboard

(C) Daughter board (D) Grandmother board

In most IBM PCs, thc CPU, the device dryes, memory expansmn slots and

active components are mountcd on a smgle board What is the name of this

board ?

- (A} Motherboard .~ - (B)  Breadboard

. (C)  Daughter board (D) Grandmother board

106. W%@ﬁm@aﬁaﬁuwﬁ

(A) Direct access

) T EIE

Magnctic disks are the most popul

(B) Sequential access

D) T @ HE R
ar medium for

-IA] Direct access (B)  Sequential access
(D)  None of these

_ (C)  Bothof these | i o 4 | | |
107. qﬁggmgqq}naﬁnéwaﬁ%ﬁ@wﬂmfﬂﬂﬂﬁ&ﬁmm@ﬂﬁwﬁ

¥ fu ST fepa AT &, T E

il technique used by codes to convert an analog signal into a digital bit stream

is known as |
(A)  Pulse code modulation __ (B) - Pulse stretcher
(D) Queue management

(C)  Query processing

------------------------------------------------------------------------------------------

----------
...............................................................
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108.

109.

110.

: qFd,

--------------

[ 74268 ] Set-B

TF VDU ¥ aR , -ar e e W e 2
Regarding a VDU, which statement is more correct ?

(A) It is an output device v (B) Itis an input device

(C) Itis a peripheral device (D) It is hardware item

T Sy TeiaRiE Swed U U A @ frmet Haer 3
(A)  Doing quick mathematical calculations
(B)  Input, storage, manipulation and outputting of data

(C)  Elcctronic data processing

(D) Pcrforming repetitive tasks accurately

A modecrn clectronic computer is a machine that is meant for
(A) Doing quick mathematical calculations
(B) Input, storage, manipulation and outputting of data __—

(C) Elcctronic data processing

(D) Performing repetitive tasks accurately

Vacuum S[d 1 T=HR T g o1 ?

When was vacuum tube invcn'te(i ?

(A) 1900 ' (B) 1906

© 1910 4 - (D) 1880

gEell digl % G § T 81 T & IARAH T o

(A)  Transistors ~ (B) Vacuum Tubes and Valves

(C) Integrated Circuits ' (D) 4 ¥ HI e
The main electronic component ysed in first generation computers was

(A) Transistors e - . (B) Vacuum Tubes and Valves

(C)  Integrated Circuits (D) None‘of these

RE-ST-608
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112. & dumb terminal e

113.

114.

(A}  ABC

A dumb terminal has

(A)  an cmbedded microprocessor

(B) extensive memory

(C)  independent processing capab1hty ¥
(D) a kcyboard and screen

Ush millisecond %

One millisecond is

(A) 1 sccond (B 10thofasecond 1
(C)  1000th of a scéond (D) 10000th of a second
s He Tgd fveE g € AR A . T €

(A) TFast (B) | Powerful

(C) Infallible (D) Cheap-'

Modern computers are very reliable but they are not

(A) Fast (B) Powerful

(C) Infallible (D) Cheap ./

115, fFrefefad § @ S 1 T fouy SU¥ aem e o4 ?

(B) ENIAC
(C)  EDVAC D) T @
Which of the following was a special purpose computer ?

(A) ABC - (B) ENIAC

,(D) All of these

-----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------
Ly
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116. SMPS &1 Saed &

SMPS stands for
(A)  Switched Mode Power Supply W

(B) Start Modc Power Supplf 7Q
(C)  Store Mode Power Suépli? i
(D)  Single Mode Powcr Supply
17. mm%f@ﬁﬁ@qﬁqm@hmaﬁwnﬁrﬁéa@ﬁmﬁ ?
(A) Flc')ppy Disk 0 (B)  Hard Disk
(C)  Compact Disk | . ! ; (D) ' Magneto-optic Disk
Which of the following storage devices can store maximum amount of data ?
(A} FloppyDisk i (B HardDisk —
(C) Compact Disk : (D) | Magneto -optic Disk -

118. 1973meﬁmzﬁwﬁ$mwwmmﬁé#ﬁézﬁ
3 Y e o 2

[A). ENIAC (B) MARK I
€ z3 S (D) ABC

Which c,omputer was conmdered the first electronic computer untxl 1973 when

court invalidated the patent ?

(A) . ENIAC i . (B) MARK I
2 ' } |
(©) (D) ABC
119. WIGHIHRIER A9RY afi ; : '
. , i (AR mﬁm‘% % I 9T & S % Physical connection %l
(A)  Path * ' 5
: (B Ad
(C)  Route | _ﬁ_: ::::S
(D)
v 742681 Qa¢ » . s Scanned with CamScanner
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.A physical conncction bctwcen

the p:
Mmicroprocessor memory and other parts of
the mlCTOCOmputer i known g P E P

(A)  Path |
. (B)  Address bus
(€)  Route !
i e (D) - All of these
12 - U, T qafrg FATGY
- o . . 2T W 'R = Fahel £
High density, -

douléle sided floppy disks could store
(A) 140MB X

(©) 1.40GB

121, 374 e H Hed auto fit T T ¥

You can auto fit the width of column by

(A) double clicking' on the column name on column header
- (B)  double clicking on the cell pointer in worksheet
(C) double clicking on column right border on column header L

(D)  double clicking on the column left border of column header

122. MS TS Fill Series SN diad H T & e fewice a4 ......... mm%.
MS Excel plrovidcs the default value ............ for step in Fill Series dialc;g box.
U 4y e ALY
) L P . D10

123. TR ¥, Curl + D ¥iewhe Feit BTN
(A)  open the font dialog box

(B)  apply double underline for the active cell

/(C) . fill down in the selection

D) T A HE

----------
............
---------------------------------------------------------

[ 74268 ] Set-B
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. . ill
Ctrl + D shortcut key In Excel W!

(A)  open the font dialog box
(B) .apply double underling 1'01' the active cell

(C)  fill down in the sglection /A

(D) none of these | :
124. Wﬁarﬁgmmq&ﬂﬂﬁ ............. Wﬂ%ﬁ(’mm-%l

(A) nght align the content of cell

11 contents of selected cells

(B)  Rcmove the cc

(C)  Fill the selection with active cells to the right
o) T A

‘The shortcut key Ctrl.+ R is use;:l in Excel to

N

(A) Right align the content of cell
[B] Remove the cciI contents of selected cells
(C) Fill the selection with active cells to the right
(D)  Nonc of these .

125. WEd:t»FﬂlmaéwﬂzﬁfaﬁmﬁmﬁFﬁ% S|

many sheets are selected

(A) - onc sheet is sclected ) (B)

(C)  no sheet is selected (D) s:rﬁ a Elﬁé e

The command Edit >> Fill Across: Worksheet is active only when

(A) onc sheet is selected (B) many sheets are selected
(C)  no sheet is sclected (D) . none of these

126. Wﬁ@ﬁﬁmmFlHSeneswwﬁmmﬂﬁ% 7

Li
' A sl : (B) Growth
(C) Auto fill ' :
' (D) Time
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which of the following series type is Not valid for Flll Series dialog box ?

(A)  Linear | ®) vowih R
(C)  Auto fill (O) Time -
g7, Tt d & @ Wﬁﬁﬁﬁqcommmdﬂmmﬂmmﬂﬁgm
& ¢ 2 |
(A)  Validation ©)' . Formats
C) Formulas (D) ECLe] o g4t
Which of the following you can paste selectively using Paste Special Command ?
(A)  Validation 2 (B) - Formats
()  Formulas (D) Allofthese

128.

129.

130.

...........

ene
........
---------
------------------------------------------

WWWWﬁaﬁﬂﬁaﬁT%ﬁaﬁmﬂqﬁﬁﬁﬁﬁﬁﬁ%?ﬁﬁﬁ
HAEAH R HAE ?

Paste Spccial allows some operation while you paste to new cell. Which of the

following operations is valid ?

(A] Squarc (B) Percentage

(C) Goal Scek D) Divide

Edit >> Delete FHIS Il ®

(A)  dcletes the content of a cell (B)  deletes formats of cell

(C)  dcletes the comment of cell (D) deletes selected cells

Edit >> Dclcte command

(A) deletes the content bf a cell (B) de_letes formats df cell

(D) deletes selected cells  _—"

T iis 6o ntcflt. of selected cel_ls you must iSSUe ...ovvrienne. command.
0 rcmove ;
(B) Edit >> Clear >> Contents

(A) Edit >> Delete i
Data >> Delete

39 /48

Scanned with CamScanner

?@ Teachingninja.in



me

T o R4 e G e T I T

A 8 R i L e T s it

207

131.

133.

134.

Pt e & o o JSCTE T & 2
What will be the output of the following line of code ?
inLA ; A =10; A++; cout<<A;

(A) 1.0 /[B) 11

€ o | (D) 9
mmﬁﬁﬁqﬁmﬁwﬁwinsmm% ?

(A)  Cul+N (B) Ctl+M

© Cul+s D) T F

Which short cut key inserts a new slide in current presentation ?
(A) Ctrl+N _~ | (B) Ctrl+M

(C) Ctrl + S (D) All of these

ST o Y +ft T ST 3

(A) Candidate key (B) Super key

(C)  Alternate key (D) Non key

Primary key is also called

(A)  Candidate key , (B) Sﬁpcr key .-

(C)  Alternate key

Right click on the Slide Panel and choose New Slide

(B)  From Insert menu chogge New Slide

(©) Click on New Slide button op toolbar
(D) 3 4@ g+
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136.

137.

...........

207

Which of the § .
ollowing methods can j mﬁert a new slide in current presentauon ? u

(W) Right click on the Slide Panel ang choose New Slide

4

=  —

(B)  From Insert menu choose New gjige

(C)  Click on New Slide button on toolbar

(D) Al oftheSR/ - | |
. ; : .

Android % Ush
(A) opcrating system _ (B) . compiler
(C)  editor |8 ' (D) interpreter

Android is a/an
| (A) | operaﬁng a-;ystein/ (B) compiler x

(C)  editor : (D) 1nterpreter
Wﬁ@ﬁnﬁmmmwaﬁmw% ?

(A)  Click the slide then press Ctrl+A and paste in new slide
(B) - From Insert Menu choose Duplicate Slide

(C) léedo évéry’thing on a new slide that you had done on previous slide

(D) T | FIE Al

What is the bcst way to create an

k the sllde then press Ctrl+A and paste in new slide

se Duphcate Shde/

other cbpy of a slide ?

(A) Clic

'(B) From Insert Menu choo

do evendhﬁlg on a new slide that you had done on previous slide
c

(C) R
(D) None of these

Float % Tch

Float is a/an

(B) variable

(A)  value

operator
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138.

139.

140.

141.

-------------

mﬁ:ﬂ@mﬁa Jwe &6, ﬁaﬁmmm%7

From which menu you can access Picture, Test Box, Chart etc. ?

(A)  File | B  Edit

(C) Insert | L (D) View

R ) Tl B ¥ 3G i 1 wafid H €
{A]. Raw & New : (B) Raw & Old

(C)  Old & Processed (D) Raw & Processed

Tefm '‘Data’ refers 10 «.c.oceevees and information refers tp R .
(A) Raw & New - _ (B) Raw & -Old

(C) Old & f’rocessed (D) Raw& Processe‘cy
TEE FoR e & el |

To insert slide numbers

(A) Insert a text box and select Insert >> Page Number

Insert a text box and Select Insert >> Number >> Page Number

(B)
(C) Choose Insert >> Slicie.Numbér \/
(D) Insert a new text box and select Insert >> Slide Number
Wwﬁqﬁ#saﬁzmm%l YRt ITH | HaA &1 Y ST ¢
g diat B HY e ? '

R1ght click on Sheet Tab of third sheet and choose Delete from the

- (A)
contcxt menu
(B) Click on Sheet 3 and from Edit menu ch-oose Delete
© (@ @) 3
()’ ¥ & FIE I

-------------------------------------------------------------------------------
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142,

143.

(A}  You can find and repl

| (B) Excel does not have 0

o wAEEE

207

By '
Y default Exce] Provides 3 worksh

ects. You need only tw :
you delete the third one ? y two of them. How will

(A)  Right click on Sheet Tap

of third sheet and choose Delete from the
context meny :

B :
(B) Click on Sheet 3 and from Edit menu choose Delete

\,(Q)/ Both (A) and (B)

(?) None of these

e 2 w2 e s 3 o e g 2

(A)  Select the sheet, then choose Edit >> Delete Sheet

(B) Sclect the sheet then choose Format >> Sheet >> Hide
(©)  (a) 7 (B) A

(D) ¥ 9§ ®IE @l

Which of the following actions removes a sheet from wo_rkbook ?
(A) Select the sheet, then choo_se Edit_ >> Delete Sheet

(B] Select the sheet then choose Format >> Sheet >> Hide

JCy~ Both (A) and (B)

(D)  None of these

Qﬂﬁﬁgﬁﬁ@a@ﬁﬁﬁ aﬁ'{aaﬂ'—’réﬁﬁm ﬁmﬁ@ﬁwwm% ?
ace within the sheet or workbook ‘

ption to match case for find

-------------------------
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207

While finding and replacing some data in Excel, which of the follow

statements is valid ?

&

(A)  You can find and replace within the sheet or workbook g
(B) - - Excel does not have option to match case for find | _
(C) Both are valid

(D) None are valid -

144, Rounﬂing errors & T&dl &

Rounding errors can occur

in a formula

(A) when you use mulﬁph’éation, division, or exponentiation
| (B)  when you use addition and subtraction in a formula
(C)  because excel uses hidden decimal b]aces in computation
' {b) - when yqﬁ show the _resﬁlts of formulas with different decimal places that
. the calculated results
145. 3T 32T A1 BIE Fid HTHHR €
(A) - With the copy, paste and cut commands on the edit menu

(B) With commands on the shortcut menu
(C)  With buttons on the standard toolbars
o) 8 af

"You can copy data or formulas

With the copy, paste and cut commands on the edit menu

(A)

(B) With commands on the shortcut menu
() With buttons on the standard tpc;lbars
(D)~ All of these |

...........................
-------------------------
............................
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You not li

cannot link excel worksheet da¢ o a word document
(A) With the right drag method
(B)  With a hyperlink

(C)  With the copy and paste special commands

With the copy and paste buttons on the standard toolbar

147.” et 3 & B v A sy s S T ¢ 2

207

Whichol-the followmg is a popular DOS based spreadsheet package ?

(A) Word (B)  Smart cell

(C)  Excel | (D)~ Lotus 1-2-3
148, T TS Tohas T € \

(A) Workbooks (B)  Worksheets

(C) " Charts (D)  Worksheets and charts

An cxccl workbpok is a collection ofi

(A) Workbooks ,2- (B)  Worksheets

(C) Charts | (LD)/Worksheets and charts
149, q@amﬁm%ﬁﬁmﬁﬂﬁm%

Excel files have a default extension of

A Xls 7 B} R
ol D) 123 |
il : ﬁé,&ﬂqﬁaﬁ?ormat?aintcraﬂmﬁmﬁ‘

150. w@qﬁﬁaﬂqiﬁ?ﬁ

Ii‘orrﬂirlt paintet
the fo rmat painter but

h multiple times before you turn it off by
You can use the

(A) Youcan use
| the format painter button -

(8) Double clicking !
the Ctrl key and clicking the format painter button
g

(C) Pressin
Alt key an

. d clicking the format paincer button
(D)  Pressing the |

--------------------------------------------------------------------------------------
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